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7t Class Computer Science (Session 2024-25)

Chapter 1%t Typing Tutor
Que:1 Fill in the blanks

1. To use number pad, should be kept ON
a) Num Lock b) Caps Lock c¢) Scroll Lock d) None of These
2. In home row, key is pressed with little finger of left hand.
a)A b) S c)D dF
3. In home row, key is pressed with Middle finger of right hand.
a)J b) K c)L d);
4. In Second row, key is pressed with ring finger of left hand.
a) Q b) W c)E dR
5. In third row, key is pressed with index finger of right hand.
a)B b) N c)M d) M, N
Que:2 Very Short Answer type Questions:
I.  For typing purpose, a keyboard can bedividedin __~ parts.

1. is the technique for typing with all fingers without looking at keyboard.
II. finger is used to press spacebar during typing.
V. key is used to go to new line during typing.
Ans: 1. Two I1. Touch Typing 1. Thumb V. Enter
Que:3 Short Answer type Questions:
Q:1 What is Touch Typing?
Ans: Touch typing is a technique by which we can learn typing with all fingers, step by step, without
having to look down at the keyboard. If all the time we keep on looking for right keys on keyboard, it
slows our typing speed a lot.
Q:2 Describe the position of our fingers on Home Row Key?
Ans: Following figure shows the position of fingers on Home Row Key:

Left Hand Side Right Hand Side

Little (Pinky) Finger Little (Pinky) Finger H

Ring Finger Ring Finger L

Middle Finger Middle Finger K

Index Finger Fand G Index Finger JandH

Q:3 What are the tips to improve typing speed?
Ans: Following are the tips to improve the typing speed:
1. Our hand/finger position should always be in home position. We must start from and return to
this position.
We should focus on accuracy not speed.
Don’t look at the keyboard.
Be steady, even pace and strive for accuracy.
As we tap each key, we should say its letter to ourselves
Q:4 Whlle typing numbers from numeric key pad, which hand we should use? Explain the position of
your fingers on numeric key pad.
Ans: Numeric Key Pad is present on right side of the keyboard. We have to use only one hand (Right
Hand) to work with its keys. For using these keys, fingers should be used as below:
e Index Finger is used for 1, 4 and 7 keys
o Middle Finger is used for 2, 5 and 8 keys
e Ring Finger is used for 3, 6 and 9 keys
o Little Finger is used for Enter, ""+" and "'-"" keys

e Thumb is used for 0 key
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Que:

Q:1

Ans:

1.

4 Long Answer type Questions:
Explain the Proper Posture while typing?

Following points should be taken care for proper posture while typing:
We should sit up straight, directly in front of keyboard.

2. Our feet must be flat on floor.
3. Monitor should be at our eye level.
4. Our eyes should be on copy or monitor.
5. Our fingers must be curved and upright over home keys. Proper Posture
Q:2 Explain following keys:
a) Enter key: It is used to move down the cursor to a new line. Use our right little finger for the Enter
key.
b) Backspace key: It deletes one character to the left of the blinking cursor. Use our right little finger
for the Backspace key.
c) Shift key: It is present on both the sides of keyboard. It is used to write capital letters or to write
the letter printed on the upper side of the key.
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Chapter 2" Windows Explorer

@JU%@J@E =

Que:1 Choose the suitable option and fill in the Blanks:

1. Windows Explorer has two panes. These are and

a) First, Second b) Left, Right c) Top, Bottom d) File, folder

2. view tells about size, type and date of modified of a file.

a) Details b) Tiles c) List d) Content

3. command is used to move an item from its place.

a) Copy b) Paste c) Cut d) Delete

4. A is a combination of pictures, colors, and sounds on our computer

a) Background b) Desktop c) Screensaver d) Theme

5A is a software program that becomes activated after the computer is not in use for
a specified duration of time.

a) Background b) Desktop ) Screensaver d) Theme
Que:2 Very Short Answer Type Questions

Q:1 Which window application is used for management of files?

Ans: Windows Explorer

Q:2 What do we call a folder inside another folder?

Ans: Subfolder

Q:3 What is a method of opening windows explorer?

Ans: Window Key+ E
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Q:4 Write the name of any default library of window.
Ans: Documents Folder
Q:5 Which option is used to make a duplicate of an item?
Ans: Copy and Paste
Que:3 Fill in the blanks:
I.  The shortcut key to create a new folder is
Il.  The shortcut key to rename a file or folders is
I11.  Deleted files or folders move to
Iv. A is @ combination of pictures, colors, and sounds on our computer.
Ans: L. Ctrl+Shift+N 1. F2 I11. Recycle Bin IV. Theme
Que:4 Short Answer Type Questions:
Q:1 How many panes are available in Window Explorer? Write their names?
Ans: There are two panes in Window Explorer which are mentioned below:
e Left Pane or Navigation Pane
e Right Pane
Q:2 Write the name of different parts of Window Explorer?
Ans: Following are the names of different parts of Windows Explorer:

1. Title Bar 5. Menu Bar
2. Back and Forward Button 6. Toolbar
3. Address Bar 7. Status Bar
4. Search Box
Recent Location Menu
Forward Button button’ Address Bar Title Bar Search Box
[ / v / ol@
Back Button—__| Ny
\Cu W=a Cibrnes v « [ 43 ][ Search¥ranies 2|
Meenu bar—— 5 fee  £dit View Tools Help
Toolbar Organize v New library - 0 9
V¢ Fevortes Libraries
B Desstop Cpen a library 1o see your files and arrange them by folder, date, and other properties.
Downloads =
: an’l ::us R Documents & Music
o Libery <&, Lty
By e S5 Pctures ﬁ Vdeos
’:;J Documents \5,7 Libeary &, Libeary
Masic
S Pictures
B videos
1% Computer
& vin(c)
S Network Right Pane
L
Left Pane | —
92 $items
—| <——— Status Bar
-

Q:3 Define File and Folder?
Ans: A file is the smallest unit to store data. To manage and organize files in the computer system, we
use folders. Folders are also called Directories. A folder may contain other folders and files.

* | Documents . a X
Home  Shae  View Folders )
& = v A4 % > ThisPC » Documents 2 Search Documents
~
# Quick access S N\
@ CreDrive SE W
® This PC ~
3 30 Objects Photos Recipes Work Aunt Cathy's
Carrot Cake
B Desktop
v Documents H-
& Downloads -
} Music Iu i &
S Pictures Budget Cover Letter 2
ises Files
L. Local Disk (C) S
Gitems  1item selected 114K8 EE
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Que:4 Long Answer Type Questions:
Q:1 What is Windows Explorer? Give different ways to open windows explorer.
Ans: Windows Explorer is also known as File Explorer. It is used to access or to work with files and
folders that are available in our computer system. Following are some common methods to open
window explorer:

e Press Windows + E keys together

e Window Key > All Programs - Accessories - Windows Explorer

e Press Window Key = Type Explorer in the search box

24 Local Disk () 3 DKL VOL2 [0 - DISKL_VOL3 (E)
5 DISKL_VOL4 (F)
. . R R Fig? 4.1 Small Icons View
Q:2 Explain different views of Windows Explorer.
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Q:3 What are the options to customize the Desktop in Windows Environment?
Ans: With the help of Personalization dialog box in Windows Environment, we can customize the
Desktop. It provides the following options to change the appearance of Desktop:
1. Themes: It provides a combination of pictures, colours, and sounds on our computer
2. Desktop Background: Desktop background primarily consists of wallpaper. A wallpaper can be
a Background pattern or a picture which can be changed using this option.
3. Screen Saver: A screensaver basically consists of animated images. Screensavers were originally

designed to help prevent phosphorus coating of older monitors from being burned.
83 ~ " » Control Pancl » A |

|| File Edit View Tools Help

Control Panel Home — -
& Change the visuals and sounds on your computer

Change desktop icons Click a theme to change the desktop background, window color, sounds, and screen saver all at once,
- — —— 3 =
S| gl
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Change your account picture
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Q:4 How can we Copy items using ‘send to’ option?
Ans: “Send to” option is an easy way to send/copy one or more items to some new location. To use this

option, perform the following steps: ik

1. Select the item that we want to copy i 4

2. Right click on the item, it will show a @ Powaiic >
shortcut/properties menu. o |

3. Click on the “Send to” option from this menu. | & =
Now a submenu will appear showing the S Bl Docimetl
different location for sending the selected items, e = :ﬁ:f:‘.:.
click on the desired location. — [EERERE

Q:5 Write about Screen Saver.
Ans: A Screen Saver is a software program. It gets activated when computer system is not used for a
specified duration of time. A screensaver basically consists of animated images. Screensavers were
originally designed to help prevent phosphorus coating of older monitors from being burned

Chapter 3"
Microsoft Word (Part-1)
Que:1 Multiple Choice Questions:
1. Ctrl + Sis used to

(a) Save (b) Open (c) New (d) Close

2. Below the ruler the large area is called the .

(a) Text Area (b) Open Area (c) Close Area (d) All of these
3. There are two scroll bars in a word document and .

(a) Horizontal, Vertical (b) Left, Right (c) Upper bar, Lower bar (d) None of these
4. To open a new document Press keys on the keyboard

(@ Ctrl+0O (b) Ctrl + N (c)Ctrl+S (d) Ctrl +V

5. The view shows the document as it will look when it is printed.

(a) Print Layout (b) Draft (c) Outline (d) Full size

Que:2 Fill in the blanks:
I. Dialog Box Launcher option is present at the bottom-right corner of
Il. Name of the top most bar of Word window is
1. view of MS Word displays the document in the same way as we get it after printing.

V. is the shortcut key to create a New document.
V. Layout view shows the Outline of a Document.
Ans: 1. Group Il. Title Bar 1. Print Layout IV. Ctrl + N V. Outline

Que:3 Short Answer type Questions:
Q:1 What is a Word Processor?
Ans: Word processors are application software. We can create a variety of documents and letters
using these softwares. WordPad, MS Word etc. are the examples of some commonly used word-
processor software.
Q:2 Write the name of some Word Processing Software.
Ans: Following are some of the important word-processing software:
1. MS Word 2. Word Perfect 3. WordPad 4. WordStar
Q:3 How to start the MS Word?
Ans: MS Word can be started using the following steps:
1. Open the Start menu.
2. Type WORD in the search box.
3. Press the Enter key.
Q:4 Write the name of different Parts of MS Word Window.
Ans: Following are the main components of the MS Word window:

|Search programs and files P

1. Title bar 2. Ribbons and tabs 3. Text area
4. Status bar 5. Scroll bar 6. Ruler
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Tabs

————— Title Bar
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adng | ReaEng
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Cursor

Status Bar
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Q:5 Define the Text”AFéa.

Scroll Bar/

Text Area

153

Ans: Text area is an important component of MS Word. The large area that appears below the ruler is
called the text area. We use this area to create our documents. The blinking line in it is called Cursor.

Que:4 Long Answer type Questions:
Q:1 Explain the Special Features of MS Word

Ans: Following are some key features of MS Word:

We can enter text anywhere in Word document.

We can set the margin of pages as per our requirement in the Word document.
We can easily find any word/text in MS Word document.

We can change the font and style of text as required in the Word document.

Ok wN e

Q 2 Explain Document Views in MS Word

We can easily set the header and footer of pages in the Word document.
We can check and correct spelling and grammar related errors in the Word document.

Ans: Following are the different views for viewing documents in MS Word:
1. Print Layout View: This view will show the document exactly as it appears after it is printed.

2.
be read easily.
3.
in the form of a web page.

o s

Full Screen Layout

Outline View: This view shows the outline of the document.
Draft View: Word document can be edited quickly with the help of this view.

QOutline View

Full Screen Layout View: This view displays the document in full screen so that the document can

Web Layout View: This view will show the document exactly as it would appear in a web browser

Print Layout Web Layout DraftEView

Q:3 How to Create and Save a New Document in  [Fons ¥
MS WO rd’) T ﬂ » ThisPC + Documents v o = Search Documents
Ans: Following are the steps to create and save a | ogme- st - @
new file in Word: CLC Deeniian |
Steps for Creating New File: g | @ Ui et

1. Press the shortcut key Ctrl + N to create a new A bediinais WS e

file. i

Steps to Save the New File: IS Pictures

1. Press Ctrl + S shortcut key to save the file. B B ;

2. Save As... dialog box will open. Fiesome [ I -]

3. Type the name of the file in this dialog box. R i e :

4. Click on Save button. [ Sev Tl

~ Hide Folders > |T

Prepared By: Vikas Kansal (CF, S.U.S. Govt. Sen. Sec. School (Girls), Sunam Udham Singh Wala) Page No: 6

(Please Visit http://cspunjab.nirmancampus.co.in for more computer science contents)



7t" Class Computer Science (Session 2024-25)

Chapter 4t
Microsoft Word (Part-2)
Que:1 Multiple Choice Questions:

1. To select a whole word, click on it.

a) Single b) Double c) Triple d) None

2. The Group of Home tab allows us to change our text font style, size, color and many
other elements.

a) Font b) Paragraph c) Styles d) Editing

3. means draw a horizontal line underneath the letters

a) Bold b) Italic c) Underline d) None

4, Option means that the text is shown like it was marked with a highlighter pen.

a) Font Color b) Text Color c¢) Text Highlight Color d) All of Above

5. After inserting a shape, a new tab will appear which is called
a) Drawing Tools Format b) Shape Tools Format c) Drawing Shapes Format d) None

Que:2 Write the shortcut keys for the following

1. To Cut the selected text Ctrl + X

2. To Paste the copied/cut contents Ctrl +V

3. To Increase the font size Ctrl +]

4. To Underline the Text Ctrl+U

5. To change the case of Selected Text Shift + F3

6. For Centre Alignment Ctrl+ E

7. For double line spacing Ctrl + Shift+ D
8. To Replace the text Ctrl+H

9. To Undo the last operation Ctrl+Z

10. To Insert Page Break Ctrl + Enter

Que:3 Short Answer type Questions:
Q:1 Write about UNDO command?

Ans: It reverses the action that we have performed while editing. If we make an Undo Retlo
error in our document then we can correct it by click on the Undo command, it il HJ") » 0’{:_
will remove the last thing we did. Ctrl+Z shortcut is used to perform Undo ‘w; 25

operation in MS Word. Undo command is also available on the Quick Access Toolbar.
Q:2 Which are basic three font styles?

Ans: Three basic font styles are:
y Bold
e Bold .
. ltalic
e ltalic Underli
e Underline ~ndetling
Insert Page Layout References Mailings Review View 9

e e T

S oA AT | Aar | B
U ~labe x, % | A%+ A

Calibri [Body]

Basic Text }( AaBbCi }J
i Change
Alignments HRagtil Styles k4

Styles

Edltlng|

Font Styles

Font [P Paragraph

Q:3 What are Headers and Footers in MS word?
Ans: The Header and Footer are the important parts of our document. Header appears in the top
margin of our document, while the footer appears in the bottom margin of the page. The header and
footer usually include information such as page number, date, author’s name, and so on. The text in the
header and footer appears on every page of the document. Insert tab is used to insert headers and
footers.

Insert | Page Layout References Mailings Review View

= [ B2 D o @

E‘d B = e+ oo 4 =

Table Picture Clip Shapes SmartArt Chart Screenshat Hyperlink Bookmark Cross-reference § Header Footer
- Art

Tables lllustrations |

Links | Header & Footer

Prepared By: Vikas Kansal (CF, S.U.S. Govt. Sen. Sec. School (Girls), Sunam Udham Singh Wala) Page No: 7
(Please Visit http://cspunjab.nirmancampus.co.in for more computer science contents)



7t" Class Computer Science (Session 2024-25)

Q:4 How many Change Cases options are available in MS Word? Write their names?
Ans: There are five Change Case options in MS Word which are given below:

L] Sentence Case Home Insert Page Layout References Mailings Review
L4 Lowercase AJ BookAntiqua ~ /12 <~ A" A o | = o=
Pasle JFormal B B 7 U - abe x, x* A\ ~ Sentence case.
o UPPERCASE
. . UPPERCASE
e Capitalize Each Word e
e Toggle case e

Q:5 How many alignments are available in MS Word? Write their names and shortcut keys?
Ans: Alignment determines the appearance and orientation of the edges of a
paragraph. There are four types of alignment in Word which are as follows:

e Left Alignment - Ctrl+L Shortcut Key

e Center Alignment - Ctrl+E Shortcut Key

Aligns all selected text bo the
Jeft margin

Aligns text an equal distance
from the left and right
margins

Aligns all selected text to the

right margin

e Right Alignment -

Ctrl+R Shortcut Key

Aligns text equally on both

sides and lines up equally te
the right and left margins

e Justified Alignment - Ctrl+J Shortcut Key

Examples of
Text Alignments

Q:6 How can we insert page break in MS word?
Ans: Page breaks are used in MS Word to insert a new page into a document. The shortcut key Ctrl +
Enter can be used to insert a page break in MS Word. Page breaks can also be inserted using the Insert
tab.

Que:4 Long Answer type Questions:
Q:1 Write about Clipboard group options of Home tab in MS Word.
Ans: The Clipboard group is the first group in the Home tab of Microsoft Office. This group has four

optionS: Hame Inse
e Paste: Itis used to paste the copied/cut contents. = gt
e Copy: Itis used to copy the selected contents. B3 Copy
e Cut: Itis used to move/cut the selected contents. PR Formatpainter
e Format Painter: It is used to copy the formatting applied on the selected text. Ellpbaald

Q:2 Write about the options available in Font group of Home tab in MS Word.
Ans: The Font group of the Home tab is used to format document text. Formatting helps us to change
the look of our document. The main options for this group are:

Font Face and Font Size:

Paste

Font Style BOId Itallc Underline Home | Insert Page Layout References Mailings
Font Color Lﬂj ?’; Cz;y Calibri (Body]  ~ 11~ A" o7 | Aa~ |

Text Highlight color
Text Effects

- ﬁFormat Painter

Clipboard

]

(B] £ U ~abe x x| A~ ¥~ A~

Fant

[P

Change Text Case

Q:3 What is WordArt? How will you insert WordArt in a Word document?
Ans: WordArt is used to insert special text-effects in word documents. When we enter WordArt into
our document, it becomes an ! R =]

object. Word art is used to [ | @ EED® ﬁ & @B B BEPR
decorate documents or to draw |=* :.:.e; M 0 O e vt G et S
special attention from the e

viewers. : T
We can insert WordArt into our | {ﬁ?ﬂ%ﬂ—%‘
documents by clicking on the |-

WordArt option in the Text
group of the Insert tab.

EEERE Tth CSin PhiFindl - MicrasaftWard i
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Chapter 5t
Microsoft Word (Part-3)

Que:1 Fill in the blanks:

1. After selecting a picture tab appears.

a) Format b) Page Layout c) Insert d) View

2. For text wrapping, we can use option.

a) Square b) Tight c¢) Behind Text d) All of these

3. To remove any unwanted parts of picture, option is used.

a) Crop b) Rotate c) Group d) Compress

4. Which of the following option is not available in the Adjust group of Format tab?

a) Corrections b) Artistic Effects ¢) Remove Background d) Picture Styles
5. We can find the number of words in the bar at the bottom of the window

a) Task Bar b) Status Bar c) Title Bar d) Scroll Bar

Que:2 Very Short Answer Type Questions

Q:1 Which option splits the text into two or more columns?

Ans: Page Layout = Columns

Q:2 Which page orientation sets the page in horizontal direction?

Ans: Landscape

Q:3 Which option is used to group two or more images together so that they can be treated as a single
object?

Ans: Format = Group

Q:4 Which option can be used to change the color of a picture in MS Word?
Ans: Format = Color

Q:5 Which option is used to count words in MS Word?

Ans: Word Count

Wi =" 9- 0]+ Documnent! - Microscft Word

Home Insert Fage Layout References Mailings Review View
HCqurs E ‘ [E —= %D{cnks' @ D Indent Spacing 5] rw i_| |__ E'L & align -
= ,, = A T = = » '
giaLine Numbers = | = Left |Oom o IE Before: Dpt ‘:I 1 E&Gr:up =

Tnemes @::n; Marglns Drler‘ltatlorl SI'Ie Collimm b3~ Hyphenation - WEtEII.'IarK EI:]alogrev BZ?:‘]g:rs E:ERIQHE ﬂu'n - :i e .1[' ot ) Fos Itl in .Tsrrp FnE‘,;\IrI:E-l Rarij:’:dm se;ﬁleon L Rotate -
Themes Page Setup [ Page Baccground Paragraph F ArTange
Que:3 Fill in the blanks:
I. Page orientation is of types.
1. mistake is shown with red wavy line under the wrong word.
1. are the blank space around the edges of the page.
V. are text or pictures that appear behind document text.
Ans: . Two I1. Spelling 1. Margins IV. Watermarks

Que:4 Short Answer type Questions:
Q:1 What are Margins?

Ans: Page margins are the spaces left around the edges of a page. We can insert headers, footers and
page numbers in the margin. To set the margins of the document, we can use the Margins option in the
Page layout tab. Margins can be set at all the 4 sides of the document- Top, Bottom, Left and Right.
Q:2 What do you mean by Compress picture?

Ans: Compressed Picture is used to reduce the size of images in our document. It may reduce the overall
size of our document. MS Word reduces the resolution (quality) of images to compress them and erases
the cropped area of the images. The option to compress images is available in the Picture Tools - Format
tab

e

I Form

% Corrections = 14 : . & Picture Border ~ g| L Bring Forward - |2+ | []] &7 1238 em *
:ﬁ % Color ~ % # Q Picture Effects = = Y Send Backward - E Y B : =
Hemeve - ' % Picture Layout = Pos-t e }Mﬂﬁe Eh selection Pane Sk~ C’.Up sas1baam . |
Adjust Plcture Styles P Arrange Size T |
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Q:3 Write about Reset picture?

Ans: If we make any changes or do formatting in a picture in MSWord and later we want to remove
the changes or formatting made on these pictures then we can do this with the help of reset picture

option. The reset picture option is available in the Picture Tools - Format tab.
Q:4 What is Crop option?

Ans: Unnecessary part of the selected image can be removed using the Crop option in MS Word. This
option is available in the Picture Tools - Format tab. After clicking this option, crop handles are made

on the edges of the selected image which can be easily used to crop the image.
Q:5 Give the name of two page-orientations in MS Word?

Ans: The Orientation option sets the vertical or horizontal direction of |« [ | feeences Maings

the page of our document. Following are the name of two page- || = |0 L] Jii...

Size Columns

orientations in MS Word:

e Portrait Orientation: It means setting the page in vertical direction ]| eorean
e Landscape Orientation: It means setting the page in horizontal [ wanoscape
direction.

¥ Hyphenation ~

R{

Q:6 Write the name of various options available in the adjust group of Picture tools format tab.
Ans: The first group in the Format tab is the Adjust group. It has the following main options:

e Corrections e Compress Picture e Remove Background
e Color e Change Picture
e Artistic Effects e Reset Picture

Que:4 Long Answer type Questions:

Q:1 What is Water Mark? Write the Steps to add a [g& . .. o vee v .
watermark in a word document? Qe 5 -

Ans: A watermark is a text or image that appears at the [
background of the document text. It is usually used to mark
the status of a document - Draft or Confidential. Here are the
steps for inserting a watermark in MS Word:

1. Click on the Page Layout tab.

2. Click on the Watermark option in the Page

Background group.
3. Select the watermark according to your requirement.

Q:2 Write the steps to run a Spelling and Grammar check? S — .
Ans: Spelling and grammar check feature is an important |snoescon:

feature of MS Word. Using this option, we can make our ||[Fo: exauple misplaced conaias ox g (mCEECTEE

Ignore All

Proofing opticn. + | | Acd to Dictionary |
] S——————— | Charge= |

correctly spelled words that may be used |

document error-free. In MS Word, spelling errors are indicated ||incorrectly et can be highlighed using
by a red wavy underline while grammatical errors are
represented by a green wavy underline. MS Word also provides
the ability to correct these errors. “Spelling & Grammar?”
option in the “Review” tab can be used for this purpose. Errors |——————— g
can also be corrected by opening the “Spelling & Grammar”

| changz Al

| aucarea |

[ Chedk arammar
dialog box using the shortcut key F7. el e |
= R RN 12t C5-Eng 2123 Motes - Migrosoft
Q:3 Explain the steps to Print a Document. IR ins it ol fws N Ao
Ans: When our document is complete, we can printitusing aprinter. | ... & ™
Here are the steps to print the document: o o
1. Click on the File menu/tab. e —
2. Click on the Print option, a print pane will appear. By
3. Select the options for printing as required, such as - range of | « e
pages, number of copies to be printed etc. R -
4. Click on the Print button. o
) Ootions A= pHnk on onc SRc it
B e E‘laf.:lzmli;: 123
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Chapter 6t
Microsoft Word (Part-4)
Que:1 Fill in the blanks:

1. key is used to move the cursor in the next adjoining cell of a table.

a) Ctrl b) Shift c) Tab d) Home

2. The table button is present on the tab.

a) Home b) Layout c) Insert d) View

3. We can change the width of a column by selecting the button in the Table Group.
a) Select b) View Gridlines c) Properties d) None of these
4. A consists of a number of columns and rows.

a) Document b) Table c) View d) Data

5A is an intersection of columns and rows.

a) Cell b) Table c) View d) Data

Que:2 Very Short Answer Type Questions.

Q:1 Which key is used to move the cursor to the next cell in a table?
Ans: Tab

Q:2 Intersection of a column and row is called?

Ans: Cell

Q:3 Which group of Layout tab contains the split cells option?

Ans: Merge

Q:4 Which option can be used to join two or more cells?

Ans: Merge Cells

= R AR Document! - Microsof: Word aOE o0
Homa Ingart Page Layout Referencas Mailings Raviaw View Design | Layout
L\\&\ E g |% E é % % % |{:|_| Height: | 0.32 cm : HI pistribute Rews E]Sz g Eﬂ %l &é_ ﬁ

S et T | P | e o (B ot | an e cpewe | M| SRS [STen 2 || B DRte Colarits | | ] [ ol | baar B
Table Rows: & Columns ) Merge Cell Size [ Alignment Cata
Que:3 Fill in the blanks:
l. provides a convenient way of writing data in rows and columns.
Il. Create table options are available in the Tables group of tab

I, a cell means to divide a cell into two or more cells.

IV. We can change the size of rows, columns and using the Properties button.
Ans: |. Table 1. Insert I11. Splitting V. Cells
Que:4 Short Answer Type Questions: Column

Q:1 Define table.

Ans: Tables are an easy way to write data in rows and columns.
Tables are often used to present data in the organized form. The table
is made up of a combination of rows and columns.

e F O

|

Insert Fage Layout Referances

= E B »

Q:2 Write the name of options for inserting a table in Word document? Bibie|| Pere Clip Shapes s
Ans: Following are the different ways to insert a table into a Word document: L rrooooal
e Using the Table button EREE
e Using the Insert Table... option 0000
e Using the Draw Table option = mEoe
e
Q:3 What is the use of Split Cells option? Cell
Ans: Splitting a cell in a table means dividing it into two or more cells. The ]
option to split the cell is available in the Layout tab of Table Tools. {!'

Aftar
Splitting Cell Ij:]
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Q:4 What is the use of Merged Cells option? I:l:]

Ans: Merge cell means to combine two or more cells in a table to form a
single cell. The option to merge cells is available in the Layout tab of Table
Tools. " After
arging Cells
Q:5 How will you enter data in Table Cells?
Ans: Click on the cell in which you want to enter data. Now type the data in the cell. Use the Tab key
or the Right Arrow key to move to the next cell of the table. Similarly, use Shift + Tab keys or Left
Arrow to move from any cell to the previous cell.

Que:5 Long Answer Type Questions:
Q:1 How do you insert a table in your document? Explain any method briefly.
Ans: There are several ways to insert a table into a document. Following is an easy way to insert a table
in MS Word document:
1. Click on the Table button in the Insert tab.
2. Click on the Insert Table... option from the drop-down menu.
3. The Insert Table dialog box appears.
4. Enter the number of columns and rows as required.
5. Click the OK button

Homa | Ingert Page Layout Referencas Mailings Fevig | Tabl B X
—] nsert Table
=l |IF LJI& :
lef* HIEE D2 & |
Cover  Dank Pﬂue Table | | Picture chu Shapes Smartért Chart Sereenshot Table size
Fage* Fage Braak -
Pages |,,,mm,|c ionis Nurmber of columns: 5 E}
T 1 1
IE |_|_ 0 “:“ :_ __;__ %% ERE Mumber of rows: 2 E}
7] | I | { AutoFit behavior
I |
|—|— LI L] %E (® Fixed column width: | Auto E}
: | |
| D[—j—:j: oo l (O AutoFit to contents
: I m ' [ DDI O AutoFit to window
Insert Table:,
% [j):r__'::l_: o [] Remember dimensions for new tables
E Excal Spreadsheet
E Quick Tables ] | kS I | Cancel
Table Propertizs 3 x
Tehie Ao Colmn cell AlLTeut
Q:2 Explain Properties button in Layout Tab? =

Ans: When we click on a table in the Word document, Layout tab will |
appear. Now click on the Properties button that is available in the Bl E|E "

-_—

Table group. It opens a dialog box. Using this dialog box, we can b e

perform the following main tasks on the tables: o —
. B ||| B8
e Set the alignment of the table = =
e Change the height of the table rows e
e Change the width of the table columns o B
e We can change the size of cells etc. e
o[ el
Chapter 7t
Introduction to Multimedia
Que: 1 Fill in the blanks by choosing the right option:
1. Multimedia is a combination of two words and
a. Images, Sound b. Audio, Video c. Multi, Media d. Hardware, Software
2. Animation is of two types, these are and
a. Analog, digital b. Static, Hyper c. Raster, Bitmap d. Path, Frame
3. Requirements for Multimedia are and
a. Images, Sound b. Analog, Digital c. Hardware, Software d. Multimedia
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4. Input Devices consists of and
a. Monitor, Printer b. RAM, Hard Disk c. Keyboard, Mouse d. Hardware, Software
5. In Multimedia, Text is of and type.
a. Analog, digital b. Raster, Bitmap c. Static, Hyper d. Path, Frame
Que:2 Fill in the Blanks:
I. A video can be classified into types.
Il. There are types of text.

I11. Path and Frames are the types of
IV. PNG stands for

Ans: |. Two Il. Two I11. Animation IV. Portable Network Graphics
Que:3 Short Answer type Questions:
Q1: What is an Animation?
Ans: Animation is an important component of multimedia. It shows motion effects on static images or
text. There are two main types of animation - path animation and frame animation. PowerPoint and
Flash are examples of commonly used animation software.
Q:2 What is Video?
Ans: Video is an important component of multimedia. In multimedia, video is used to represent
information in a much better way. The video can be played with motion pictures as well as sound. There
are usually two types of videos: analogue and digital videos.
Q:3 What is Multimedia Conferencing?
Ans: Multimedia conferencing is also called video conferencing. This is an important application area
of multimedia. Using it, we can have face-to-face conversations with people living at distant places.
Que:4 Long Answer Type Questions:
Q:1 What is Multimedia? Explain the Components of Multimedia.
Ans: The word multimedia is a combination of the two words - Multi and Media. Multi means two or
more and media means medium. Thus, multimedia is a technology in which information is distributed
using a variety of mediums. The following are major components of multimedia:

e Text: Written information is called text.

e Sound: Sound helps us to explain an idea clearly.

e Animation: It is the motion effect on static images or text.

e Images: Images are an essential part of multimedia.

e Video: Video contains motion pictures as well as sound.

lCDmponents of Multimedia‘

Text

Sound Animation

Images ‘ Video

Q:2 What are the requirements for Multimedia?
Ans: The basic requirements for multimedia are hardware and software. These are as follows:
Hardware Requirements:

1. Input device

2. Output device

3. Storage devices
Software Requirements:
These are used to modify and manage the elements of multimedia. For example: Adobe Director, Media
Blender, Multimedia Builder, etc.
Q:3 What is a Multimedia Presentation? What should we keep in mind before preparing Multimedia
Presentation?
Ans: A topic can be presented effectively using multimedia presentation. Text, sound, video, animation,
and pictures are the important components of a multimedia presentation. Following are some of the
points that we should keep in mind before preparing a multimedia presentation:
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1. Text should be kept minimum.

2. Sound quality should be good.

3. The user should be able to use the keyboard and mouse.

4. It should be small in size.
Q:4 Write down Applications of Multimedia
Ans: Multimedia is used in many fields. Some of the important application areas of multimedia are
given below:

1. Multimedia is used in the field of education.

2. Multimedia is used to represent the model of human body in medical science.

3. Multimedia is used in the field of entertainment.

4. Itis used to inform customers at railway stations, banks etc.

5. It is used for face to face communication with people living far away.

Chapter 8"
Storage Devices

Que:1 Fill in the blanks:
1. Primary memory is also called

a) Internal memory  b) External memory c¢) Physical memory d) Auxiliary memory
2. memory is not a Read Only Memory.

a) ROM b) PROM c) EPROM d) RAM

3. is not a portable storage device.

a) External Hard Disk b) Pen Drive c) Hard Disk Drive d) Memory Card

4. The memory is divided into number of small parts called

a) Cells b) Area c) Inter-section d) None of these

5. USB means

a) Uniform Service Book b) Universal Serial Bus

c) Universal Straight Bus d) Uniform Serial Bus

Que:2 Very Short Answer Type Questions:
I. Storage Capacity of Floppy disk is
Il. Storage Capacity of Compact Disk (CD) is
1. memory unit is usually used to measure the Storage capacity of hard disks.
IV. ROM stands for
V. computer port is used to attach Pen drive.
Ans: 1.1.44MB 11.700 MB IIl. Gigabyte (GB) IV. Read Only Memory V. USB
Que:3 Short Answer type Questions:
Q:1 What is memory? Write down two main categories of memories?
Ans: Any medium that has the capacity to store data Memory
is called memory. Memory is divided into many _ T
smaller parts, called cells. Memory is used to store FrimaryMemory Secondary Memory

. . . . Memory Card
data and instructions. The two main categories of N\ i
) 9 RAM Rom HardDisk - CD Pen Drive
memory are: Floppy Disk DVD

1. Primary memory Magnetic Tape
2. Secondary memory

Q:2 Write the name of any four Secondary Memory devices?

Ans: The names of the secondary memories are as follows:

. Hard disk

. External hard disk

. Floppy disk

. Magnetic tape

. Compact Disc (CD)

. Digital Video Disc (DVD)

. Pen drive

. Memory card
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Q:3 What is Memory Card? Memory
Ans: Memory card is a portable secondary memory. It is also called a flash memory card.
These cards are commonly used in mobiles, digital cameras, MP3 players, etc. Memory cards
are usually used to store pictures, movies, songs, and other data.

Q:4 Write a short note on pen drive.

Ans: The pen drive is a portable secondary memory. It is a USB based memory device.
It is used to transfer data from one computer to another. It is very small in size and its
speed is faster. They also have higher storage capacity.

Que:4 Long Answer type Questions:

Q:1 Write a note on Primary Memory?

Ans: Primary memory is also called Main Memory or Internal Memory. The CPU has direct access to
this memory. Micro-conductors, which are very fast and special types of electronic circuits, are used to
make this memory. These memories are also called Semiconductor memories. These memories have low
storage capacity. There are two types of primary memory:

1. RAM: RAM stands for Random Access Memory. This
memory only stores those data and instructions that the
computer is working on.

2. ROM: ROM stands for Read Only Memory. This memory
stores the instructions to start the computer.

Q:2 What is HDD? Explain?
Ans: HDD stands for Hard Disk Drive. This is the most commonly used -
secondary memory. The stored data remains in this memory even after the
computer is turned off. Its speed is slower than primary memory. A hard disk
consists of one or more metal plates, called Platters. These plates are coated
with a layer of metal-oxide to store data. These plates rotate at a speed of 5400
to 7200 RPM (rotation per minute). Hard disks have a high capacity to store
data. Its storage capacity is usually measured in gigabytes (GB).
Q:3 What is Secondary Memory? Explain any one secondary memory device?
Ans: Secondary memory is also called external memory or physical memory or auxiliary memory. The
stored data remains in this memory even after the computer is turned off. Hard disk drives, optical
storage disks, floppy disks, etc. are examples of secondary memory devices.
Hard Disk Drive (HDD): A hard disk consists of one or more metal plates, called platters. These plates
are coated with a layer of metal-oxide to store data. These plates rotate at a speed of 5400 to 7200 RPM
(rotation per minute). Hard disks have a high capacity to store data. Its storage capacity is usually
measured in gigabytes (GB).
Q:4 Write precautions that we must follow while using a CD/DVD.
Ans: The following precautions should be taken when using CD / DVD:

1. The CD/DVD should be kept in the cover.

2. The bright side of the CD / DVD should not be touched.

o
"
3. The bright side of the CD / DVD should not be written with ‘
pen or pencil. ’

4. Do not bend CD/DVD.

5. A soft cloth should be used to clean the CD / DVD.
Q:5 What is External Hard Disk drive? Write its advantages?
Ans: External hard disk is a secondary memory. It is a portable type
of secondary memory, which can be easily moved from one place to
another. This is a USB based memory device. It has a very high
storage capacity. It iscommonly used to back up data. Once the data
is backed up, it can be removed from the computer and stored in a
safe place.
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